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Introduction

Aortic regurgitation (AR) refers to backward blood flow from the aorta into the left
ventricle (LV) during ventricular diastole. The regurgitant jet arising from the complex
shape is characterized by the three-dimensional flow and high-velocity gradient,
sometimes limiting an accurate measurement of the regurgitant volume using 2D
echocardiography. Recently developed four-dimensional flow magnetic resonance
imaging (4D flow MRI) enables three-dimensional volumetric flow measurements,
which can be used to accurately quantify the amount of the regurgitation. This
study focuses on (i) magnetic resonance compatible AR model fabrication (dilatation,
perforation, and prolapse) and (ii) systematic analysis of the performance of 4D flow
MRI in AR quantification. The results indicated that the formation of the forward and
backward jets over time was highly dependent on the types of AR origin. The amount
of regurgitation volume bias for the model types were -7.04%, -33.21%, 6.75%, and
37.04% compared to the ground truth (48 mL) volume measured from the pump
stroke volume. The largest error of the regurgitation fraction was around 12%. These
results indicate that careful selection of imaging parameters is required when absolute
regurgitation volume is important. The suggested in vitro flow phantom can easily be
modified to simulate other valvular diseases such as aortic stenosis or bicuspid aortic
valve (BAV) and can be used as a standard platform to test different MRI sequences

in the future.

Aortic regurgitation (AR) refers to the backward flow from
the aorta into the left ventricle during the diastolic phase of
the ventricle. AR is typically classified into aortic dilatation,
cups prolapse, cups perforation, cups retraction, and others’.

Chronic AR may cause the volume overload of the LV mainly

due to hypertrophy and dilatation, and eventually causes its
decompensationz. Acute AR is mainly caused by infectious
endocarditis, aortic dissection, and traumatic rupture, which

leads to hemodynamic emergenciesz.
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Current clinical standards for AR diagnosis are mainly based
on transthoracic echocardiography (TTE) or transesophageal
echocardiography (TEE)3. Despite the advantages of real-
time imaging and short exam time, the accuracy of
echocardiography is highly operator-dependent. Especially
for the regurgitant volume measurement, direct measurement
of the regurgitant volume is limited as the regurgitant jet
shifts out of the two-dimensional (2D) measurement plane
due to the motion of the aortic valve. Indirect estimation using
proximal iso-velocity surface area (PISA) methods are often
used, but assumptions such as circular orifice area often limit

the accurate measurement?.

Recent medical guidelines® also recommend cardiac MR
(CMR), especially for moderate or severe AR patients
to compensate for the limitation of echocardiography by
measuring the mass and global function of the LV. Structural
parameters such as aortic leaflets and LV size, and flow
parameters such as jet width, vena contracta width, and
regurgitant volume can also be comprehensively considered
in AR diagnosise. However, aortic regurgitation volume
estimated with the LV global function may fail especially for

patients with other heart valvular diseases or shunt.

Alternatively, 4D flow MRI has been considered as a
promising technique that can directly measure the regurgitant
volume with time-resolved velocity information within the
volume of interest’. The motion of the valve according
to the time can be easily tracked and compensated
when measuring the regurgitant flow volume®:9. Also, an
arbitrary plane perpendicular to the regurgitant jet can be
retrospectively positioned, which increases the accuracy
of the measurement'?, However, as the 4D flow MRI

inherently obtains the spatiotemporally averaged information,

the accuracy of this technique still warrants validation by using

well-controlled in vitro flow experiments.

This study aims to (i) develop MRI compatible in vitro
experimental platform that can reproduce the different clinical
scenarios of AR (dilatation, perforation, and prolapse) and
(i) enrich our understanding of 4D flow MRI performance in
quantifying different AR at these AR models. In addition, 3D
hemodynamic visualization and quantification based on 4D
flow MRI were conducted according to the various clinical
scenarios. This protocol is not limited to AR and can be
extended to other types of valvular disease studies that
require a series of in vitro experiments and hemodynamic

quantification.

Protocol

NOTE: The protocol is largely composed of three stages: (1)
model fabrication, (2) MRI scan and parameter selection, and
(3) data analysis. Figure 1 is a flow diagram showing the

overall process of the protocol.

1. Model fabrication

1. Aortic root model

1. As shown in Figure 2, determine the parameter
values of the aortic root, such as valve base

diameter and sinus radius. For this experiment, the

values were DA = 32.24 mm, Do = 26 mm, L

8.84 mm, Lp = 26 mm, rmin = 16.64 mm, rmax

21.32 mm.

2.  Run the 3D modeling software by clicking Sketch >
Tools Sketch Tools > Sketch Picture.
NOTE: Solidwork is used for 3D modeling in the

experiment.
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2.

To make a sinus model, sketch circles

corresponding to rmax and rmin using the circle tool.
Draw a curved line of the sinus using the free curve

function”, click Loft Tool and select the sketch

area for loft.

Sketch additional circles on the top and bottom of
the current model, click Extrude Tool, and select the
circles. Set the options as 20 mm downward and 30
mm upward. Make a hexahedron model of size 100

mm x 100 mm x 76 mm in the same way.

Click Combine Tool from Insert > Features >
Combine. Select Subtract in the property manager.
Select the hexahedron model and the sinus model.
Fabricate the final design as an acrylic model
with a 5-axis CNC machine as per manufacturer's

instruction.

Valve frame

1.

Run 3D modeling software and open a new sketch.
Draw a square of size 100 mm x 100 mm and a circle
of 25 mm in the center for the valve base, manually.
Click the Extrude Tool and adjust the height of the

valve base to 5 mm.

Extrude the circle with a height of 23.5 mm and a
thickness of 3 mm thick. Divide the model into 12
uniform pieces using Line Tool so that each piece
has 30°. Select three pieces with 120° intervals and
extrude with a height of 16.5 mm to make three

pillars.

Click Fillet Tool and select the pillars. Adjust the fillet
radius at the top and bottom as 4 mm and 10 mm,

respectively. Save it in an STL file format.

4. 3D-print the valve frame. Set the infill density to
100% and use acrylonitrile butadiene styrene as fill
material. See Figure 3 for the shape and dimensions
of the aortic valve frame.

3. Aortic  regurgitation model using  expanded

polytetrafluoroethylene (ePTFE)

1.

Run the 3D modeling software and open a new
sketch. Draw a horizontal line of 23.24 mm and a
vertical line of 15 mm with reference to Figure 4A.

NOTE: The geometric parameters of the valve's

base, height, and leaflet free-edge length were

chosen according to a previous study12.

Click 3 Point Arc Tool from the arc command
manager and set two points on each end of the
horizontal line and the last point on the end of the
vertical line. Extrude the sketch with a thickness of
5 mm. Export the model with STL file format and 3D
print it.

Overlap the ePTFE membrane in two layers and
draw three leaflet borders at intervals of 2 mm using
the printed leaflet. Suture along the drawn lines and
side borders at 1 mm intervals with a polyamide
suture with a diameter of 0.1 mm. Suture the ePTFE
valve from top to bottom on the frame at 1 mm

intervals.

Cut the outer side of the membrane and suture
it with each other. Perform the following three

modifications to obtain three different models.

1. Dilatation model: Reduce the ratio of the

designed leaflet parameters to 90%.
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2. Perforation model: Make a circular hole with a
diameter of 2 mm using scissors in the center

of one leaflet.

3. Prolapse: Fix the two commissures of the valve
at a hole with a low post height.
NOTE: Figure 4 shows the materials and
fabrication method of ePTFE valve. Figure 5

shows the characteristics of each AR-type.

2. MRI scan and parameter selection

1. Prepare the experimental system consisting of an AR
model, aortic sinus model, a heart simulation pump, and

MRI.

2. Set the experiment models in the MRI room and connect
the pump, reservoir, and models using a 25 mm (inner
diameter) silicone tube. Use a 10 cm long cable tie to

fasten the connection parts to prevent possible leakage.

3. Use a motor-controlled piston pump to simulate the aortic
blood flow waveforms to generate a physiological flow
waveform through the flow circuit system. Use water as
the working fluid and attach one-way valves to the inlet

and outlet to prevent backflow. Details of the flow pump

can be found in the previous study23.

4. Locate the model within the field of view (FOV) of the
MRI. Perform a scout scan to observe phantom images
in the coronal, axial, and sagittal views in MRI operating
console monitor. This image is used as a guide to position

the following image sequences.

5. Locate the 2D image plane in the center of the aorta
model. Run a variable velocity-encoding parameter
(VENC) 2D phase-contrast imaging to select the most
appropriate VENC value for 4D flow MRI.

Set VENC to a 10% higher value in 4D flow MRI to

minimize possible velocity aIiasing7. Enter the desired
spatial resolution and the temporal resolution on the
MRI console. The spatial and temporal resolution for the

aortic flow is recommended to be 2-3 mm and 20-40 ms,

respectively7. Table 2 shows the MRI scan parameters.

Acquire data for both with and without flow using the 3

types of AR valves and the without valve.

3. Data analysis

1.

2.

Data sorting and correction

1. Copy raw data files from the scanner to proceed
with the data analysis. Sort the dicom files according
to the header named series description using the
Dicom sort software. Click Sort Images in Dicom
sort software to sort three-directional phase images

and magnitude images in separate folders.

2. Load magnitude image into the ITK-snap software.
Click Brush in the ITK-snap and manually paint the
internal fluid region of the phantom using the brush

tool. Save segmented image.

3. (Optional) Load both phase image data obtained
with the flow on and off using MATLAB. Subtract the
data with the flow by the data without flow to remove
background errors. Repeat this for every direction

and cardiac cycle.

4. Calculate the velocity of 5D matrix phase data (row
x column x slice x direction x time) using a vendor-
specific pixel-to-velocity equation. In general, the
maximum intensity of the pixel corresponds to the

selected VENC value.

Visualization
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1. Load the 5D matrix velocity from step 3.1.4 into flow
visualization analysis software.
NOTE: Input velocity matrix may vary according to

the analysis software. Ensight users should follow

Ensight gold case format guide13.

2. Click the Isosurface Part, change the data type
from isosurface to isovolume for 3D analysis by
clicking the Isovolume button. Drag the speed data
in the variables command manager, add it to the
isovolume to check the velocity distribution of the

model.

3. Click Particle Trace Emitters Tool in the main
menu. Check Advanced Option for a more accurate
analysis. Select the desired visualization such as

Streamlines or Pathlines in creation.

4. For this experiment, set the following value: Emit
From Option = Part, Part ID = 2, No. of Emitters =
10000, Direction = +/-. Create and check the results

over time.

5. Right-click the Particle Trace model and click the
Color by. Select the velocity component to color the

streamline with the velocity.
3. Quantification

1. Load the velocity data (step 3.1.4) and segmented
image (step 3.1.2) onto MATLAB. Set the velocity
outside of the segmentation region to zero. This can
be easily performed by elementwise multiplying the

segmented matrix data and the velocity matrix data.

2. Check if the velocity data has phase-wrapping using
the Imshow function of MATLAB. Inversion of the

velocity direction indicates phase-wrapping.

3. Slice the desired plane of the matrix data. Sum
all velocity data within the plane and multiply
spatial resolution to calculate the flow rate through
the plane. Sum all flow rates throughout the
cardiac cycle and multiply the temporal resolution to

calculate the stroke volume.

Representative Results

Three representative classes of aortic regurgitation models
were fabricated, and one case without a valve was fabricated
for comparison (Figure 3). The dilation model clearly showed
incomplete closure of the valve leaflet due to the smaller-
sized leaflets. A hole was punctured on one of the leaflets
using scissors to mimic the perforation model. One leaflet of
the prolapse model looked smaller than the other two leaflets
because the two commissures were sutured at a position
lower than the original height. There were no significant

differences from the top view.

With the 3D velocity information acquired over time using 4D
flow MRI, streamlines of normal and regurgitation jets were
visualized during systole and diastole (Figure 6). The forward
jet was straight in all models except for the perforation model.
In the perforation model, a wall-biased jet occurred during
the systole phase. The regurgitating jet showed a different
velocity and shape according to the AR classification. In the
case of without a valve, an overall forward and backward
flow occurred. The regurgitant jet of the dilation model came
out from the center and tended to change directions over
time. The perforation and prolapse model regurgitant jet
leaned toward the wall. The peak velocity of the forward and
regurgitant jet was 0.28 m/s, -0.29 m/s in the model without

valve, 2.03 m/s, -3.53 m/s in the dilatation model, 2.52 m/s,
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-3.13 m/s in the perforation model, and 2.76 m/s, -2.88 m/s

in the prolapse model.

Figure 7 shows the flow rate for each valve and the
forward and regurgitant volumes in a 3D plane away from
the valve base. The flow rates showed different waveforms
and quantities for each model. The amount of regurgitation
volume was 51.38 mL, 63.94 mL, 44.76 mL, and 30.22
mL for without valve, dilatation, perforation, and prolapse

models, respectively. The bias for without valve, dilatation,

Model fabrication

MRI scan and
parameter selection

Data analysis

perforation, and prolapse model were -7.04%, -33.21%,
6.75%, and 37.04%, respectively, compared to the ground
truth (48 mL) measured from the pump stroke volume. The
positive percentage values indicate underestimation while the
negative percentage values represent over estimation. The
regurgitation fraction error was -7.78%, -6.00%, 0.33% and

-11.18% for without valve, dilatation, perforation and prolapse

model, respectively.

Figure 1: Workflow diagram of the protocol. This experimental protocol mainly consists of model fabrication, MRI scan,

and data analysis. In the model fabrication step, the outer aortic root model and four different types of AR model (without

valve, dilatation, prolapse, and perforation) are fabricated. During the MRI scan, scout imaging followed by multi-VENC

scan and 4D flow MRI is performed. The data analysis part includes data sorting, image segmentation, velocity calculation,

visualization, and quantification. Please click here to view a larger version of this figure.
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26.00 mm

26.00 mm

Figure 2: Schematic and designed acrylic model of the aortic root (A) Geometrical characterization and parameters of
the aortic root geometry. (B) Aortic root 3D model in multi-dimensional view. DA: diameter of sinotubular junction (STJ), DO:
diameter of annulus, rmax: maximum sinus diameter, rmin: Mminimum sinus diameter, LA: height of sinus, LB: height of STJ.

Please click here to view a larger version of this figure.

Pillar

Circular body
100 mm

16.5 mm

Without valve Dilatation

LT S

Perforation Prolapse

Figure 3: Aortic regurgitation frame and model (A) Geometrical information of the aortic valve frame which is used to hold
the leaflet. Holes around the body of the frame is where the suture line passes. (B) Example of ePTFE membrane sutured
valve. (C) En-face view of the in vitro models: without valve, dilation, perforation and prolapse fabricated in this study. The

arrow indicates the damaged cusp. Please click here to view a larger version of this figure.
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Figure 4: Material and fabrication step of ePTFE leaflet. (A) Using 3D printed leaflets as a guide, leaflets are made using

ePTFE membrane. (B) Drawing, suturing, cutting and fixing steps of the ePTFE valve. Please click here to view a larger

version of this figure.
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23 mm
*

. J:‘sm s J : ::-_ - ;: S mm:](‘ - ﬁ/\ :
Size reduction o e o \_ﬁ >>

Figure 5: Fabrication methods of different AR models. (A) Dilatation model, (B) perforation model, and (C) prolapse

model. Please click here to view a larger version of this figure.

February 2022-180 - €63491 - Page 8 of 14

Copyright © 2022 JoVE Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported jove.com

License


https://www.jove.com
https://www.jove.com/
https://www.jove.com/files/ftp_upload/63491/63491fig04large.jpg
https://www.jove.com/files/ftp_upload/63491/63491fig04large.jpg
https://www.jove.com/files/ftp_upload/63491/63491fig05large.jpg

jove

A B Opening Closing C Opening Closing D Openlng Closlng

O OO0 OO Oo

Systole  Diastole Systole Diastole Systole n.astulp Systole Diastole

Speed Speed .

s ] m/s mis|
120[rn s] e ] 120[ |
0.80 0.90
0.60 0.60 0 50
0.30 E 0.30 E 0 30
0.00 0.00 0.00
Without valve Dilatation Perforation Prolapse

Figure 6: Streamline visualization according to aortic regurgitation type. A streamline visualization at systole (left of
each panel) and diastole (right of each panel) according to aortic regurgitation type. (A) Model without valve (the diastole/
systole image are the same due to lack of a valve), (B) dilatation, (C) perforation, and (D) prolapse. Systole and diastole data

were taken where the inlet velocity is the highest and the lowest during the cardiac cycle. Please click here to view a larger

version of this figure.
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Figure 7: Flow rate and stroke volume. The flow rate and stroke volume for (A) model without valve, (B) dilatation,

(C) perforation, and (D) prolapse. The flow rate and stroke volume are measured at the plane (solid line) three-diameter

downstream to the valve annulus. The blue and red colors indicate the forward and regurgitating flows, respectively. Please

click here to view a larger version of this figure.

Ratio
(Do= 26 mm)

LBIDO

rmax/Do

rmin/Do

1.24 1

0.34

0.82

0.64

Table 1. Geometrical parameters of the aortic root geometry shown in Figure1.

Temporal resolution

0.025 ms/40 phases

Spatial resolution

2mm x 2mm/0.5 pixel per 1 mm

Matrix 96 x 160 x 26 pixel
Slice thickness 2mm
Echo time 2.54 ms
Encoding velocity 25-330 cm/s

Table 2. 4D Flow MRI sequence parameters in vitro.
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Discussion

Four-dimensional flow MRI has recently been verified by
various ex vivo and in vivo studies as an application
for clinical routine use'. As the 4D flow MRI obtains
3D velocity information over the entire cardiac cycle,
one strong application is a direct quantification of the
valvular regurgitant volume, which conventional 2D Doppler
echocardiography is not capable of quantifying15. In vitro
experiments using 4D Flow MRI can provide the 3D flow
velocity and related hemodynamic parameters which can be
used for investigating the relationship between cardiovascular
disease and hemodynamics. However, despite its promising
capability, no systematic studies on this application have
been reported yet. This is possibly due to the lack of well-
controlled in vitro experiments that mimic the regurgitation of

the tri-leaflet valves.

Recent developments in in vitro studies have provided more
accurate and realistic experimental methods to access the
pre- and post-valvular hemodynamics16'17. Coupled with
an optical image-based particle image velocimetry (PIV),
accurate measurement and quantification of the flow around
the valve was possible in previous in vitro studies'8.
However, accurate 3D flow fields, especially for the post-
valvular flow, were limited owing to the opaque model and
refraction. On the other hand, 3D velocity measurements
using MRI were also limited, as metal components cannot be

used!9:20

Hence in this study, a protocol to build a flow experimental
platform that is MR compatible and highly modifiable to
reproduce various clinical scenarios of valvular diseases is
introduced. The ePTFE membrane is used to mimic the
tricuspid valve without metal components as it has been

widely used as a valve and vascular graft material due to

its high tensile strength and chemical resistance’-21.22,

Based on ePTFE films, three different origins of the AR
have been reproduced (dilatation, perforation, and prolapse)
as well as a model without a valve for comparison. The
next important step in this flow experimental protocol is MR
imaging and quantification. A motor-controlled piston pump
that can simulate the aortic blood flow waveforms is used
to generate a physiological flow waveform through the flow
circuit system. Details of the flow pump can be found in the
previous study23. As this study also aims to validate the
accuracy of the 4D flow MRI in flow quantification, all the
imaging parameters are selected based on the previous study
which summarizes the parameters that can be used in the
clinical routine?. As the MRI system includes inherent errors
due to imperfections such as eddy currents and nonlinearity
of the magnetic field2, the background correction strategy is
applied prior to the actual data quantification as described in

step 3.1.3.

The hand-made aortic regurgitation model suggested in
this study showed similar hemodynamic characteristics of
regurgitant jet according to model classification as previous
studies reported26'27. The closed shape was symmetrical,
and a straight jet occurred at the center of the valve in the
dilatation model. A posteriorly directed eccentric jet appears
owing to cusp damage in the perforation model. Partial
prolapse of the valve shows a jet whose direction was bent
from the culprit cup owing to limited mobility. The aortic
regurgitation volume directly measured using the 4D flow
MRI was overestimated in the without valve and dilatation
model, while it was largely underestimated in the prolapse
model when compared with the ground truth. However, when
the regurgitant fraction was calculated, the largest bias was
only 11% in the prolapse model. This strongly indicates

that not only the regurgitant flow but also the normal aortic
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jet was affected by the MR scan. At the current stage,
individual scan parameters were not optimized for each AR
model. A future systemic parameter study may improve the
accuracy of regurgitant volume measurement. Alternatively,
the use of regurgitant fraction is more robust as it cancels
out the inherent errors in 4D flow MRI but also is clinically
more relevant than simply measuring the absolute regurgitant

volume.

In conclusion, this study suggests an MR compatible in
vitro flow experimental model that is highly modifiable to
simulate various types of AR. Also, the accuracy of AR
volume measurement using 4D flow MRI was compared. The
limitation of this study is that the motion of the aortic valve
was not simulated, which can affect the actual development
of the regurgitant jet. In addition, the partial volume effect and
temporal averaging nature of the 4D-flow MRI may limit the
accuracy of the flow measurement, especially considering the
high dynamic range of velocity within the jet and surroundings.

Therefore, further systematic parameter study is required.
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